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Copyright Statement 

 

Our company 

All rights reserved. 

 

Our company reserves the right to modify the products and product specifications 
described in this manual without advance notice. 

Our company is not responsible to any direct, indirect, or consequential damage or liability 
caused by improper use of this manual or the product.  

Our company owns the patent, copyright or any other intellectual property right of this 
product and the related software. No one shall duplicate, reproduce, process or use this 
product and its parts, unless authorized by our company. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

All the name refered in this manual only for identification, if belongs to other company’s 
registered trademark or copyright, proprietary rights of the name belongs to their respective 
holder. 
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Foreword 

Thanks for purchasing the laser engraving machine control system of our company.  

Before operating, please read this manual carefully to ensure proper operation.  

Please keep the manual properly for reference.  

Since the configs are different, certain models do not have the functions listed in this manual. 
Please refer to the specific functions for details. 

Due to the constantly tech update, the specification for reference only, subject to the real 
standard. 

 

 

 

Tags in this book： 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

Alarm 

Special Attention: User must follow and perform as the manual, 
otherwise, it could lead to errors or relatively serious problem. 

Note 

Note: User should comply with the attention and suggestion in this 
manual, it could bring much easier operation. 
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Chapter 1 Software Introduction 

1.1 Software Introduction  

SmartCarve4 series software is a fire-new software which designed by our company. Support 
process control create data of a majority of laser equipments. With computer aided design (CAD), 
computer intelligent control, graphics processing, multi-data formats import, multi-craftwork of 
laser processing, multi-layer setting and support many languages. Introductions follow: 
u CAD functions, including the drawing and editing of point, line, rectangle, polygon, 

circular arc, ellipse, Bezier curve, text, etc. node editing is supported, allowing users to 
adjust the graphics precisely in a more convenient way; it also supports advanced 
graphical editing such as moving, rotating, mirroring, stretching, shearing, aligning, 
cloning, filling and gray level adjust. 

u Supporting to import data in plt, dxf, dst, dsb, ai, nc, bmp, jpg, gif, out, oux,ymd, yln, cut, 
smc etc. formats. 

u Providing simple graphics processing. Including move, rotate, mirror, stretch, shear, align 
and clone the vector figure and bitmap. Supporting the net dealing, invert dealing and 
gray level adjust of bitmap. 

u Capable of modifying the starting point and direction of cutting of graphics, and 
multi-node editing. 

u Capable of closed modification of curve and curve clipping. 
u Providing ruler showing, easy to know clearly about the figure size and position. 
u Providing several manners of viewing figures, such as zoom in, zoom out, etc. 
u Supporting many languages. SmartCarve 4 series software support Unicode, it support all 

the languages in theory. Make the xml file for the standard format, easy to modify the 
language. The default languages are Chinese (Simplified), Chinese (Traditional) and 
English. Users can increase or decrease and modify language if need. 

u Supporting as many as 256 processing layers; Users can set the processing parameters for 
the different layers and the priority of processing layers according to the requirements of 
processing. 

u Supporting many kinds of motion controllers; including No.1 controller, No.3 controller, 
No.4 controller. Not only support cutting machine, but also support vision machine, 
feeding machine, marker, etc. Processing data can be saved as *.oux (No.1 .1 controller) 
file or *.ymd (Third Controller) file and downloaded to the machine. 

u Capable of saving all figures and processing parameters of the current project. 
u With virtual printer input function. Input the figure to SmartCarve4 to process through 

virtual printer. 
u Supporting graphics layout and edge layout with dual laser heads. 
u Supporting as many as 256 times of undo and re-do operations. 
u Providing shrink and expand feature for curve zoom edit. 
u Supporting to draw and edit the leadin and lead out line. 
u Capable of compensation of closed curve. 
u Supporting small graphics to drill and drill to small circle features. 
u Providing advanced layout in array way. 
u Supporting curve line data smoothing feature. 
u Providing a function to optimize the path of cutting data. 
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u With figure track simulation function. 
u With light guide function. Easy to create the process data of light guide. 

 

1.2 Software Installation 

1.2.1 Installation Requirements 

Operating system: Windows 2000/XP/vista/win7 (32bits or 64bits) 
PC: 
  CPU: >1GHz 
  Memory: > 1GB 

1.2.2 Edition Introduction 

 

 

 

 

 

 

 

Fig. 1-1  

SmartCarve 4 series have the following editions: 

Ø SmartCarve4.1: the first edition of SmartCarve4 series, only used for machine with No.1 
controller. 

Ø SmartCarve4.2: base on SmartCarve4.1, support No.1.1 controller, No.3 controller, No.4 
controller and vision cutting machine. 

Ø SmartCarve4.3: base on SmartCarve4.2, improved the capability and function, it can 
replace the SmartCarve4.2. 

Ø SmartVision: the software which the vision cutting machine (SM960) used, base on 
SmartCarve4.1, stop using now. 

Ø SmartScanner: the software which laser marker machine used, base on SmartCarve4.3, it 
will be introduced in marker software manual. 

 

 

 

Alarm 

ü No.1 controller can only use SmartCarve4.1, No.1.1 controller must use 
SmartCarve4.2 and the above version software. 

ü Our company will not update the software which stop using, but we still 
have the software copyright. 

ü Different edition has different function and capability, this manual default 
use SmartCarve4.3 to introduce. 

SmartCarve4. X. XX. XXXXXX 

Software series： 

SmartCarve4 

SmartCarve4 series 

Main edition 
number： 
1：4.1 
2：4.2 
3：4.3 
… 

hypo-edition 
number： 
1：.1 
2：.2 
3：.3 
… 

Release date： 
110818： 

2011-8-18release 
… 
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Note 

Update and support the software is a continually way. We will release the 
new software through the website of our company. Users can acquire the 
update information and download the new software from our website. 

 

1.2.3 Drive Installation 

Different machine has different controller, some controller needs install the driver to work. 

Ø 1st Controller 
Need install the USB device driver, please read the “User Manual of NO.1.1 Control 
System”. 

Ø 3rd Controller 
No driver is required. 

Ø 4th Controller(PCI) 
Need install the PCI card driver, please read the “User Manual of 4th Control System”. 

Ø Vision Machine 
Need install the PCI card driver and the camera driver, please read the “User Manual of 
Machine Vision System”. 

Ø NestCutting(PCI) 
Need install the PCI card driver, please read the “User Manual of NestCutting”. 

Ø Marker 
Need install the laser marker controller driver.  

1.2.4 SmartCarve4 Installation 

1) Insert the soft CD into CD-ROM (or hard drive), find the SmartCarveInstall4.X.XX.exe and 
double click it, and then the following dialogue box will show up: 

  

Fig. 1-2  

Select your language, then click “OK”: 

 
Fig. 1-3  

2) Please wait till the system enters the following welcome interface: 
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Fig. 1-4  

3) Click “Next” 

 

Fig. 1-5  

4) Click “Browse” to locate the path of the target folder, and click “Install”: 

  

Fig. 1-6  

5) Wait for the final prompt for completion: 
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Fig. 1-7  

6) After the installation, a shortcut icon of SmartCarve4 will be displayed on the Windows 
desktop. Users can double click this icon for execution or select “Run SmartCarve4.3” 
upon completion of installation to run the software. And the following dialog box pops 
up: 

  

Fig. 1-8  

Select the current language in the “Software Language” item, and select your required 
machine type in “Machine Type”. Then, click “OK” to start the software. 

Softdog is required upon the initial use. If the soft can’t check the correct softdog, user can’t 
use this software, and the follow warm dialog will be shown: 

 

Fig. 1-9  
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Note 

If users haven’t the softdog, “SmartCarve4.X_Demo” icon on the 
desktop could be used for the free test. The free time limit 10 days.  

 

 

 

Alarm 

ü Re-install the software or operation system cannot delay the free time. 

ü Please keep your softdog well, if lose, please contact our company to 
buy another one. 

 

1.3 SmartCarve4 Uninstallation 

1. Click “Start”-> “All Programs”-> “SmartCarve4.3”-> “Uninstall”, the dialogue shows up: 

  

Fig. 1-10  

2. Click “Next”, the following dialogue box will show up as soon as the progress bar 
completes: 

 
Fig. 1-11  

3. Wait till the following dialogue box shows up upon completion: 
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Fig. 1-12  

4. Click “Finish” to complete. 
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1.4 Operational Flowchart 

 
Fig. 1-13 Operational flowchart  
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Chapter 2 Software Application 

2.1 Software Interface 

  
Fig. 2-1 Main interface 

  

Fig. 2-2 Drawing Area 

Interface description: 

Ø System toolbar: It includes such functions as New, Open, Save, Cut, Copy, Paste, Cut out, 
Undo, Redo, Zoom Window, Move and View. 

Ø Graphics list box: It shows all graphics list included in the drawing area. 

Ø Graphics property settings: Set the property of graphics, such as position, size, etc.  

Layer list 

Description of layer parameters 

System toolbar 
Primitive 
Graphic list box 

Primitive Graphic attribute 

Alignment tool 

Settings area of layer parameters 

Drawing toolbar 

System toolbar 

Graphic list box 

Graphic property settings 

Alignment toolbar 

Layer parameters 
Drawing toolbar 

Layer list 
Other toolbar 

Description of layer parameters 
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Ø Drawing toolbar: Capable of drawing basic graphics such as line, rectangle, circle, etc. 
Import of all formats of figure and analog printing are supported.  

Ø Layer list: It shows 256 layers and the cutting sequence.  

Ø Setting area of layer parameters: Set the layer parameters and processing parameters.  

Ø Description of layer parameters: Describe details of all parameters in the layer 

Ø Alignment toolbar: When a figure is selected, you can use the tool to arrange the 
position of this figure. 

Ø Other toolbar: editing and modifying figure, net transfer and machine setting. 

Ø Drawing area: It is an area for drawing and editing figure. 

 
Note 

User can click key on the dialogue box of graphics list or layer list to 
hide or display it at any side of the screen.  

 

2.1.1 Menu bar 

The menu bar after clicking “New” : 

  

Fig. 2-3 Menu bar 

2.1.1.1 File (F) 

 

Fig. 2-4  

New (Create a new document) 

Open (Open a smc project file)  

Close (Close the document)  

Save (Save the current project as *.smc project file)  

Save as (Save the project file as another file path) 
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Import File (Import graphics file of all kinds of support formats) 

Import File to Lib (Import graphics file to graphics library) 

Export File (Save current graphics as *.ymd/*.plt/*.nc file) 

Carver Out (only available for No. 1.1 controller, engraving output) 

Net Transfer (only available for Third controller, transfer or manage the data via Ethernet)  

Exit (close the software) 

2.1.1.2 Edit (E) 

 

Fig. 2-5  

Undo (Cancel the current operation and return to the previous state) 

Redo (Resume the previous undo operation) 

Delete (Delete the selected graphics) 

Copy (Copy the selected graphics) 

Cut (Cut the selected graphics) 

Paste (Paste the graphics that is previously copied or cut) 

Cut out(Clip the curve) 

Clone (Array copy for the selected graphics) 

Add graph to lib (Add selected graphics to the graph library) 

Prev Graph(Select the previous graph) 

Next Graph (Select the next graph) 

Curve Edit (Modify the bezier2 graphics by transition shaply, smoothly, symmtrically) 
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2.1.1.3 Draw (D) 

 

Fig. 2-6  

Pick (Select the graphics function) 

Edit node(Edit the node of graph) 

Line (Draw a line) 

Rectangle (Draw a rectangle) 

Regular polygon (draw a regular polygon) 

Ellipse (Draw a circle or an ellipse) 

Bézier curve (Draw a Bézier curve) 

Text (Draw letters or characters) 

Drill (Draw a drill graph (point)) 

Bitmap file (Import image files of different formats such as BMP, JPG, etc.) 

Vector file (Import vector files of PLT, DXF, DST, DSB, AI, out,oux, cut, nc, yln or ymd format) 
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2.1.1.4 Modify (M) 

 

Fig. 2-7  

Mirror (Perform mirror function at X or Y direction on the selected graphics) 

Fill (Fill in the closed curve) 

Coordinate (Set the system coordinate) 

Convert Line(Transfer the graphics to curves) 

Convert Dashed (Transfer the graphics to dashed curves) 

Optimize Path (Optimize the cut path) 

Shrink and Expand(Shrink or expand the curves) 

Add Lead (Add leadin or lead out line) 

Set Curve Precision (Set the curve processing precision) 

Link Line (Link multi-line to one line) 

Close Curve (Make the curves closed) 

Drill to small circle (Transfer drill graphics to small circle) 

Small graph to drill (Transfer small circle to drill graphics) 

Group (Group multi-graphics to a group) 

Scatter Group (Scatter a group to multi-graphics) 

Convert Array (Convert the selected graphics to array) 

Scatter Array (Scatter array to many unattached graphics) 

Convert Leftover (Convert the selected graphics to the leftover of array graphics) 

Detach Leftover (Detach the leftover graph from array graph) 

Convert to Light Guide (Fill the selected graphics to light guide graph) 
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2.1.1.5 View (V) 

 

Fig. 2-8  

Grid (Show or hide the background grid in drawing area) 

Ruler(Show or hide ruler in drawing area)  

Switch (Show or hide the interface of switch dialogue) 

Layer List (Show or hide the interface of layer setting) 

Graph List (Show or hide the interface of graphics list and attribute) 

Tree List (Show or hide the graphics list tree) 

Graph library(Show or hide the interface of graph library) 

Toolbar (Show or hide the main toolbar, edit toolbar, draw toolbar, bezier toolbar, etc.) 

Control bar (Show or hide the control panel, only available for 4th controller or vision machine) 

Vision bar (Show or hide the vision panel, only available for vision machine) 

Standard view (Resume the software interface to the default status) 

Snap Graph (wether to snap the graph node on drawing or editing) 

 

2.1.1.6 Tools (T) 

 

Fig. 2-9  

Language (Many languages are available) 

machine (select the controller or machine type) 
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machine settings(Set the related system parameters of device according to the selected 
machine type) 

jog control (Only available for No.1.1 controller, to control the machine move or laser test) 

config (config parameters of this software) 

 

2.1.1.7 Window (W) 

 

Fig. 2-10  

New window(Create a new window in the current document) 

Cascade (Stack up all windows one by one) 

Tile horizontally (Place all windows by column) 

Tile Vertically (Place all windows by row) 

As well as all names of created windows in the software (select as required) 

 

2.1.1.8 Help (H) 

 

Fig. 2-11  

Helps(SmartCarve user manual) 

Help/Controller(User can view the manual of current used controller) 

About (Software version and copyright statement) 

 

2.1.2  System Toolbar 

2.1.2.1 Main Toolbar 

 

Fig. 2-12  
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Function: New, Open, Save, Cut, Copy, Paste, Cut out, Undo, and Re-do.  

2.1.2.2 View Toolbar 

 
Fig. 2-13  

Function: It is used to switch the drawing window and view the details of figure in the drawing 
area. 

Zoom Window: By clicking this button, you can then press the left key of the mouse in 
drawing area to zoom in the figure or the right key to zoom out the figure. 

Zoom Pan: You can move the view in the drawing area by clicking this button, or by 
pressing the middle key of the mouse. 

Zoom in: By clicking this button, you can zoom in figure in the drawing area. 

Zoom out: By clicking this button, you can zoom out figure in the drawing area. 

Zoom all: By clicking this button, you can display all drafted figures in the drawing area. 

Zoom Area: Press and hold the left key of mouse to draw a rectangle, and the system 
will zoom in the selected area. 

View WorkSpace:clicking this button, you can display the entire work area in the 
drawing area. 

 

2.1.2.3 Graph Modify Toolbar 

 

Fig. 2-14  
Function: Group, Scatter, Convert Array, Scatter Array, Fill, Shrink and Expand, Add 

Leadin/Lead out line, and Close Curve. 

2.1.2.4 Machine Toolbar 

 

Fig. 2-15  

Function: Network transmission, undo some operations (such as cancel the printer input 
status), export file, carve output, Machine setting, track simulation. 
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2.1.2.5 Drawing Toolbar 

  
Fig. 2-16  

Function: Graph selection, node edit, line, rectangle, regular polygon, ellipse, bezier curve, 
bezier2 curve, text, picture import and vector graph import. 

For details, please refer to 2.2.2Figure Drawing and Attribute Settings. 

 

2.1.2.6 Alignment Toolbar 

 
Fig. 2-17  

Function: Move to origin, align to left, align to right, align to top, align to bottom, align to 
center, same width, same height, same size, horizon evenly, and vertical evenly; for details, please 
refer to 2.2.3.9 Alignment. 

 

2.1.2.7 Bezier Toolbar 

 
Fig. 2-18  

Function: transition sharply, transition smoothly, transition symmetrically. For more details, 
please refer to 2.2.2.9 Bezier curve2. 



SmartCarve43 software manual 

-18- 

 
 

2.1.3 Status Bar 

The bottom position of the software interface: 

 
Fig. 2-19  

Progress bar: It shows the progress when processing data. 

Cursor coordinate: It shows the real-time coordinate of cursor. The unit is mm. 

 

2.2 Software Operation 

2.2.1  File 

The system supports graphics files of many formats: plt, dxf, ai, cut, nc, dst, dsb, jpg, bmp, out, 
oux, ymd, yln, smc, etc. 

2.2.1.1 Save and Open SMC Files 

The SMC file is used to save the project, include parameters, graphics, processing data, and 
system parameters for the current project. 
Ø Save SMC files 

Open SmartCarve4, create a new file and edit it. Then click button or press “CTRL+S”, 
the following dialogue box will show up: 

 
Fig. 2-20  

Input file name, and then click “save”. 
 
Ø Open SMC files  

Cursor coordinate Progress bar 
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Open SmartCarve4 and click in the toolbar, if select “show preview” it will show the 
file graphics in the preview area as the following figure: 

 

Fig. 2-21  

Select a project file of *.smc format, such as test.smc in the above picture, and double 
click it to open. 

 

Fig. 2-22  

When open the SMC file, the machine type must be the same as the saved file, or it 
cannot be opened. The following dialog will show up: 
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Fig. 2-23  

Ø Importing SMC  

Click the Import vector graph  button in the drawing toolbar or press CTRL+2 to pop up 
the dialog box to open a file. Select “Smc Files (*.smc)” in the dropdown list, choose the 
corresponding SMC file, and click to open it. 

 

Fig. 2-24  

The import of SMC file only enables the graphics data to be imported instead of the 
parameters in the file, so there is no need to set the same machine type during the import. 

 

2.2.1.2 Import Picture 

Import Picture: After clicking button, click button in drawing toolbar as shown in 
the following dialogue box will then show up: 
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Fig. 2-25  

Select the file type (BMP or JPG, etc) and find the file to be opened from the dialogue box, and 
then double click it to open it. As a default, the system will change the open picture to 256 gray 
level bitmap. 

Bmp Property: Select the picture and the bitmap attribute area will show the private attribute 
where user can set the different values to adjust the selected picture. 

 
Fig. 2-26  

Gray level: Regarding the color grade, 2, 4, 8, 16, 32, 64, 128, or 256-color is supported. The 
lower the color grade is, the more distorted the picture would be. The system default is 256-color. 

 
Fig. 2-27 Unprocessed picture (256-color) 
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16-color        2-color 

Fig. 2-28  

Net: Select this option and click “Apply”, and the picture will be changed to a net dot picture 
with only black and white colors as follows: 

 

Before         After 

Fig. 2-29  

Invert: Reverse the color of each pixel in the picture. In the picture, the black part is resulting 
from laser giving out light when the machine is carving, while the white part is because the laser 
does not give out light. 

 

Before        After 

Fig. 2-30  

Y Scan Interval (mm): The space between two pixels at Y direction, the unit is mm. Its default 
value is the same as the picture’s resolution of Y direction (DPI Y). 

X Scan Interval (mm): The space between two pixels at X direction, the unit is mm. Its default 
value is the same as the picture’s resolution of X direction (DPI X). 
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Ascent (mm): If a value is set here, the edge of carved figure would then have gradient. 
Generally, the gradient is started from the periphery of line. The smaller the value is, the steeper 
the gradient would be. There is no gradient when the value is 0. 

Sweep direction: Set the engrave direction of carving processing. 

X single sweep means the laser goes from left to right (or right to left) every time when 
scanning, and after scanning a line, it is closed and return to the left (or right) of the next line to go 
on scanning. 

X double sweep means the laser goes from left to right (or right to left) when scanning, and 
after scanning a line, it jumps to the right (or left) of the next line and starts scanning again. It 
repeats this operation until the end of the scanning. 

Y single sweep means the laser goes from up to down (or down to up) every time when 
scanning, and after scanning a column, it is closed and returned to the top (or bottom) of the next 
line and go on scanning. 

Y double sweep means that the laser goes from up to down (or down to up) when scanning, 
and after scanning a column, it jumps to the bottom (or top) of the next line and starts scanning 
again. It repeats this operation until the end of the scanning.   

 

X –single sweep X-double sweep Y –single sweep Y-double sweep 
Fig. 2-31  

2.2.1.3 Import Vector File 

Import Vector File: Take Corel DRAW X3 as an example. Open Corel DRAW X3 and draw a 
figure: 

 
Fig. 2-32  

After that, click “File” -> “Export” from the menu bar, and a dialogue box shows up: 
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Fig. 2-33  
Save the figure as “PLT-HPGL Plotter File”. Enter the file name and click “Export”, a dialogue 

box as below shows up: 

 
Fig. 2-34  

Note that in “Page” option, the graph plotter unit is set as “1016”. It could also be set as other 
values; however, the same value should be chosen when SmartCarve4 is importing later. 

 
Fig. 2-35  

In “Advanced” option, the small the “Curve resolution” is, the better the curve precision 
would be. Other parameters could be set as defaults. 

Save as “PLT-HPGL Plotter File” 

1016 
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Fig. 2-36  

Importing into SmartCarve4: Click button in the drawing toolbar to import the vector 
diagram, and the following dialogue box will show up: 

 
Fig. 2-37  

Select PLT (*.plt) in file type, and select the required PLT file to open. 

The following dialogue box will then show up: 
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Fig. 2-38  

Resolution: 1000DPI, 1016DPI, and others (Input DPI manually) are available. 

Usually, the DPI should be set as the same as that of original drawing when the PLT file is 
importing. 

The default value is 1016DPI. Click OK to import the file, and the interface is shown as follows: 

 

Fig. 2-39  

 

2.2.1.4 Export File 

Ø Exporting *.oux file 

Note 
*.oux file is applicable to No.1.1 Controller. 

The software is capable of saving the drafted figure as *.oux file. This file can be downloaded 
to the machine to allow off-line working. 

After drafting the figures, click  button in toolbar, and a dialogue box will show up as 
follows: 

 
 

 
Note 

Ø The system supports the vector files in the format of *.plt, *.dxf, *.dst, *.dsb, *.ai, 
*.nc, *.cut, *.out, *.oux, *.ymd, *.yln, *.smc, etc. 

Ø The ai format supports Adobe Illustrator 5.0~ Adobe Illustrator 8.0 for this moment. 
Ø The method of importing *.out file supported by No.1 controller is the same as that 

of importing *.ymd file, which is supported by Yueming 3rd Controller. 
Ø *.yln file is generated by Camera Scan & Layout System, and user can import this 

kind of file directly. 
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Fig. 2-40  

Enter the file name and click “Save”, a dialogue box will show up: 

 

Fig. 2-41  

Here you can set all the output parameters of figures, such as how many lines or column is 
going to be replicated, origin mode, etc. Then, click “OK” to finish save file. 

Ø Exporting *.plt file 

The software is also capable of saving the drafted vector graphics as *.plt file. 

Likewise, after drafting the figures, click button in toolbar, and a dialogue box will show 
up as follows: 

 

Fig. 2-42  

Select “plt files (*.plt)” in “Save as type”, enter the file name and click “Save”, a dialogue box 
will pop up: 
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Fig. 2-43  

Select the resolution and click “OK” to finish save file. 

 

Note 

Now, three graph of format cannot be saved as PLT format: 

ü Drill graph 

ü Fill graph 

ü Bitmap 

 

Ø Exporting *.ymd file 

 
Note 

*.ymd file is only applicable to Third Controller. 

With a config of Third Controller, the software is capable of exporting the figures as *.ymd 
files and downloading it to Third controller using the “Network transmission” function. 

After drafting the figures, click button in toolbar, and a dialogue box will show up as 
follows: 

 

Fig. 2-44  

Select the Data Type and click “OK” to save it as file of ymd format. 

Ø Exporting *.nc file 
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Nc code also named G code, it is an international standard program code with CNC, often 
used to CNC machine. SmartCarve4 support to import and export this format file, mainly G00, 
G01, G02, G03, etc. 

 

2.2.1.5 Graph Library 

The library is provided for users to save graphics. Users can save common figures into it. 
A. Import Files to Lib (CTRL+L) 

In the menu bar, select “File”->”Import Files to Lib (CTRL+L)”, and a dialog box pops up: 

 

Fig. 2-45  

The importable file formats are PLT and DXF. Select a file and open it. In the menu bar, click 
“View”->”Graph Lib”, and the opened figure is listed in the graph library. 

 

 
Note 

The default import type is “Overall import file”, when this option is chose, then  
the whole graphics of the plt or dxf file can be imported to the graphic library as a graphic 
unit. If this option isn’t chose, then the graphics of the plt or dxf file can be imported to 
the graphic library by separate. (If the file type is dxf file and the file have block, then the  
graphics of graphic library was named by the block name of the dxf file.)  

User can right click the blank area of the graphic library to choose the “Overall 
import file” option. 

 
B. Add to Graph Lib (CTRL+I) 
Ø Select one or more graphics from line, group, ellipse, polygon, Bézier, rectangle and text. 
Ø Click “Edit”-> “Add to Graph Lib” in the menu, or use the shortcut CTRL+I or click “Add to 

Graph Lib” from the right-click menu to add the graphics to the library. A dialog pops up 
at the moment to prompt you to enter a name, as shown in the picture below: 

    
Fig. 2-46  

Ø After entering the name, click “Ok” or directly click “Ok” to add the graphics to the lib, as 
the following picture shows: 
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Fig. 2-47  
Ø Users can edit the graphics in the lib by renaming, deleting the currently selected 

graphics, or deleting all graphics. Upon right clicking, a menu as shown below pops up: 

  
Fig. 2-48  

Ø The interface of graph library can be displayed horizontally or vertically. 

  

Horizontally display 
the graphic lib 
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Fig. 2-49  

Ø Modify the figure name: right click the figure which need to modify in the layer list, a 
dialog box will pop up: 

 

Fig. 2-50  

Click “ok” after modifying. 

C. Drag graphics from graphic library to workspace 

User can drag graphics from graphics library to workspace by press the left button and keep 
press status to move the mouse to the workspace, then user can roll the mouse wheel to rotate 
the graphic during the moving. After the left button loosen, the graphic can be draw in the 
workspace and then software can mirror the graphic automatically, user can continue to insert the 
graphic to workspace by press the left button, and also can press the right button to cancel. 

2.2.1.5.1 Advanced features of the graph library 

Click the menu “Views” à “Graph library” to show the graph library panel, right-click on the 
blank area:  

Vertically display 
the graphic lib 
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Fig. 2-51  

Overall import file: All graphics elements of the file imported will be combined into one 
graphic unit, and then import it to the list. Or else, all graphics will be broken into a separate 
graphics.  

Mirroring import file: All graphics are imported, and then a mirror of them is generated at the 
same time. 

Delete all: Delete all graphics in the library list. 

Add by pair: According to the characteristics of the shoe industry, mark a “pair” property to 
those graphics imported. When the graphic is dragged out, a pair of the graphic will be forced to 
generate. 

Set number: Set the maximum number of graphics in the list. When the number becomes 0, 
the graphic cannot be dragged out. 

1) Overall import file 

For example, the original figure of the dxf file is shown as below: 

 
Fig. 2-52 the original figure 
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Fig. 2-53  

The left picture shown above is using the option of “Overall import file”, and the right is not. 

2) Mirroring import file 

For example, the original figure of the dxf file is shown as below: 

 

Fig. 2-54  
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Fig. 2-55  

The left picture shown above is using the option of “Mirroring import file”, and the right is 
not. 

3) Set number 

For example, there is an order form. All graphics in the list are set maximum number to be 20. 

 
Fig. 2-56 Import graphics 

Right click the option “Set Number” of the menu. 
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Fig. 2-57 Set number 

4) Arrange graphics using the library 

In the above case, set max number to be 20. Arrange the first two graphics of the library list to 
be two arrays. Two arrays are arranged in 2 rows and 5 columns. And then its corresponding graph 
reduction 10. 

 
Fig. 2-58 Arrange two arrays 

When the number of graphic becomes zero, the graphic cannot be dragged out again. 

 
Fig. 2-59   

2.2.2 Drawing and Graph Attribute 

In the following, we are going to introduce how to draw graph and how to set the attribute. 

Number becomes zero    

Reduced 10 
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2.2.2.1 Graph Selection 
Select a single graph: 
It is done by pressing the left key of the mouse on a single graphics. First, click the button 

on drawing toolbar, and then click the figure that you want to select by pressing the left key of the 
mouse. The state of figure being selected is shown as follows: 

 

Fig. 2-60  

Property of enclosing rectangle can be set in attribute setting area of the graphics. 

  

Fig. 2-61  
Select multi-Notele figures: 
Method 1: By mouse 

Click the button in drawing toolbar, and press the left key of mouse in a place of drawing 
area to fix the starting point of the rectangle, and then hold and drag the mouse to adjust the size 
of rectangle until a desired rectangle is drawn. All figures inside this rectangle are selected. 
Detailed operations are shown as follows: 

A dashed-line selection rectangle formed by dragging the mouse: 

 
Fig. 2-62   

As the following picture shows, figures inside the selection rectangle are selected: 

Height of enclosing 
rectangle 

Width of enclosing 
rectangle 
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Fig. 2-63  

Method 2: By operating graphics list 
You can also select one or many figures in the graphics list. 
Select a graphics from the tree control in list by clicking the left key of mouse, and the relevant 

graphics in the drawing area will also be selected. 

 
Fig. 2-64  

If you select “Layer 1” in the tree control, all graphics under this layer will then be selected; or 
you can press the Ctrl key and click the graphics in the list to select. 

 
Fig. 2-65   

 

2.2.2.2 Object List Operation 

Object list is a dendriform list frame, use to show and manage the current drawing figure as 
follow: 

 
 

Note 

A. MulNotele-choice function: you can use the Ctrl and Shift keys on keyboard to 
select the figures conveniently. 
Press ea the Ctrl key and click the graphics in the drawing area, all selected graphics 
will be in checked status. If you click the selected figure again, the checked status 
will disappear. 

B. Press the Shift key and click the graphics in the drawing area, all selected graphics 
will be in checked status. If you click the selected figure again, it will be changed to 
modification state and node editing state. 

 C. Shortcut of Select All: Ctrl + A 

Height of enclosing 

rectangle 
Width of enclosing 

rectangle 
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Fig.2-57 Object list 

The object list separate into three tiers: the first tier is “document”, the second is layer, the 
third is graphics. The array gradation is the deferent process gradation. We can select and move 
the graphics through the mouse. Right click the graphics, it will pop up a dialog box to modify 
graphics name, users can named the graphics by yourself. 

 

2.2.2.3 Graph Node Editing 

Draw a line, polygon or Bézier curve, and then select and double click it to enter the node 

state (or click button in the drawing toolbar and then click the graphics) when the graphics will 
have several key points displayed as small hollow rectangles, you can drag these key points with 
mouse to edit the graphics. 

In node editing state, move the cursor on any edge of graphics and double click it to add a 
new node. You can double click it on this node again to delete the node. 

    
Figure is selected       Node editing state 

Fig. 2-58  

For s line, it is able to operate more nodes. More details, please refer to 2.2.2.4. 

For rectangle, it is able to operate inverse round by editing the nodes. More details, please 
refer to 2.2.2.5. 

For regular polygon, it is able to zoom in, zoom out or rotate it by editing the nodes. More 
details, please refer to 2.2.2.6. 

For ellipse, it is able to form a section of circular arc by editing the nodes. More details, please 
refer to 2.2.2.7. 

For Bezier, it can be edit more by editing the nodes. More details, please refer to 2.2.2.8 and 
2.2.2.9. 
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2.2.2.4 Line 

How to draw: Click button in the drawing toolbar to enter the straight line drawing state, 
and click in the working area successively to set the nodes of straight line, and then click the right 
key to pop up menu as: 

 
Fig. 2-59  

If you select “End”, the straight line drawing will be ended. 

If you select “Input coordinate”, a dialogue box will show up: 

 
Fig. 2-60  

User can set the precise coordinate value of X and Y axes to confirm the position of node. 

Note 

Press “control” can draw a string which given angle, every 15°one angle. It is 
convenient for user to draw a horizontal line or the line which given angle. 

1、 Move node 

Ø Move single node 

Click discretionary node of straight line, then move the mouse. At this moment, a new straight 
line will move follow the mouse as follow figure: 

 

Fig. 2-61  

Ø Move multi-node 

Move the nodes by pressing and holding the left key of mouse, draw a rectangle dashed frame, 
then loosen the left key. At this moment, multi-node would be chosen, then move discretionary 
node of multi-node, other chosen node will move by the same distance as follow: 



SmartCarve43 software manual 

-40- 

 

Fig. 2-62  

2、 Delete node 

Ø Delete single node 

Move the mouse to one node, then double click the left key of mouse, the current node will 
be deleted. 

Ø Delete multi-node 

Select multi-node, double click one node of the multi-node or press “delete” key of keyboard, 
the all chosen nodes will be deleted. 

3、 Add node 

Move the mouse to any string of the straight line, double click the left key of mouse, a new 
node will be add at the double click position as follow: 

 

Fig. 2-63  

4、 Modify the direction of curve 

It can only modify the direction after switch curve, when the figure is not closed, it can only 
set the start point or end point for the start point. When it is close curve, it can set any point of 
close curve for the start point, it can also set the working direction. 

When it is not close curve, it only has the “reverse” function. Right click the mouse, the right 
key menu will pop up as follow: 

 

Fig. 2-64  
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Click “reverse”, the direction of curve will change as follow: 

 

Fig. 2-65  

When it is close curve, it can use “reverse” and “set the start point”. 

 

Fig. 2-66  

The “reverse” function is the same as the unclose curve. 

Set the start point: Move the mouse to any node of current close curve, right click the mouse, 
select “set the start point”, set the current node for working start point. 

 

Fig. 2-67  

 

2.2.2.5 Rectangle 

How to draw: Click button in the drawing toolbar to enter the rectangle drawing state, 
press and hold the left key of mouse to set one of the endpoints of rectangle in drawing area, and 
then drag the mouse to adjust the rectangle size until the end of drawing. 

Enter the node editing state, select and drag any one of the four nodes to get the rectangular 
fillet. 
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Enter the nodeed state    Move the nodes 

Fig. 2-68  

Property settings: Likewise, select a rectangle, and the rectangle property will be displayed in 
the graphics property area, where user can set different values to adjust the selected rectangle. 

 
Fig. 2-69 Attribute dialogue box 

As shown in the above picture, in addition to the property of enclosing rectangle (the same as 
line mentioned above), there is also the own attribute: 

Width (mm): Set the width of rectangle. 

Height (mm): Set the height of rectangle. 

Round radius (mm): Set the fillet radius of four circular arcs of rectangle. 

 

Fig. 2-70  

Fillet radius 
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Note 

You draw a square instead of rectangle if you press and hold the Ctrl key when 
drawing. 

 

2.2.2.6 Regular Polygon 

How to draw: Click button in the drawing toolbar to enter the regular polygon drawing 
state, and then press and hold the left key of mouse in drawing area to adjust the size of figure 
until a desired figure is drawn. 

Select the regular polygon to enter the node editing state, and then click the left key on key 
nodes to drag to change the size or to rotate the figure. 

 
Fig. 2-71  

Property settings: Select the regular polygon and the property will be displayed in graphics 
property area, where user can set different values to adjust the selected regular polygon. 

 
Fig. 2-72  

Edges count: Set the edge numbers of regular polygon. The default is 5, and the maximum is 
500. 

Radius (mm): Set the distance from the center to each vertex, that is, the radius of 
circumscribed circle.  

 

2.2.2.7 Ellipse 

How to draw: Click button in the drawing toolbar to enter the ellipse drawing state, and 
then press and hold the left key of mouse in drawing area to adjust the size of figure until a desired 
figure is drawn. 

Select the ellipse to enter the node editing state, and then click the left key on key nodes to 
drag to adjust the start angle and end angle of ellipse. 
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Fig. 2-73  

Attribute settings: Select the ellipse and the attribute will be displayed in attribute area, 
where user can set different values to adjust the selected ellipse. 

 
Fig. 2-74  

Start Angle(degree): As shown in the following picture, unit in degree 

End Angle(degree): As shown in the following picture, unit in degree 

 

Fig. 2-75  

Rotate Angle: An angle at which the graphics circles around the center, unit in degree 

Long Radius(mm): the major axis of ellipse, as shown in the following picture, unit in mm 

Short Radius(mm): the minor axis of ellipse, as shown in the following picture, unit in mm 

Center (mm): X and Y coordinates of center position of ellipse 

 

Fig. 2-76  

Center coordinates 

Short Radius 

Long Radius 

End Angle Start Angle 
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If the major axis is equal to minor axis, it is a circle. 

Current direction: Click this button to set the direction as clockwise or anti-clockwise 

 Ellipse is drafted clockwise. 

Ellipse is drafted anti-clockwise. 

Note 

To draw a circle instead of ellipse if you press and hole the Ctrl key 
while drawing. 

 

2.2.2.8 Bézier Curve1 

How to draw: Click button in the drawing toolbar to enter the Bézier curve drawing state, 
and press the left key of mouse in different places of the drawing area, and then press the right key 
to pop up menu as: 

 

Fig. 2-77  

End line: End the drawing of Bézier curve. 

 
Fig. 2-78  

Close: The last node and the first node of Bézier curve are Linked to form a closed curve. 

Set coordinate: Pop up dialogue box, just the same as straight line settings, user can set the 
precise X and Y coordinates. 

Drawing the Bezier is base on the point of curve to account Bezier curve automatically. The 
node edit function can modify the point position, it can support to edit mutil-node. 

The steps as follow: 
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Fig. 2-79 Before edit 

 

Fig. 2-80 Editing 

 

Fig. 2-81 After edit 

 

2.2.2.9 Bézier Curve2 

How to draw: Click button in the drawing toolbar to enter the Bézier curve2 drawing 
state. 

Drawing manner: left click mouse, one point will show in the drawing area. If you want to 
modify the coordinates of control point, you can click and hold the left key of mouse and move it. 
You will see two control points change follow the mouse, move it to the appointed position and 
then loosen it. 

 

Fig. 2-82  



SmartCarve43 software manual 

-47- 

If you want to end the current drawing, right click the mouse, choose any one to end in the 
right key menu. 

 

Fig. 2-83  

End line: End the drawing of Bézier curve. 

Close: The last node and the first node of Bézier curve are Linked to form a closed curve. 

Bezier curve is through control point to create curve, it is support to edit mutil-node. 

 

Fig. 2-84  

² Move node 

The move manner of node is as the same as straight line. 

² Delete node 

The delete manner of node is as the same as straight line. 

² Add node 

The manner is as the same as straight line, but add node will not hold the primary curve. 
If you add node on one curve, the primary curve may distortion. 

 

Fig. 2-85  

Double click 
to add node 
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Fig. 2-86  

² Curve edit 

You can modify the Bezier curve2 at current node editing manners through these two 
manners: one is modify the coordinates of control point, another is edit curve directly. 

Ø Control point manner 

1、 Switch to node editing mode, click any node of curve.(not include start point and 
end point). At this moment, four control points will appear: back control point of 
front node, front control point and back control point of current node, and front 
control point of back node. Through these four control points can modify the curve 
of current chosen node. (Start point only has back control point, end point only has 
front control point.) 

 

Fig. 2-87  

2、 If the current chosen nodes are not start point and end point, the icon of Bezier 
toolbar in effect. Toolbar will choose a edit mode base on the connection of current 
chosen node. As above figure, current node and its control points are in the same 
line, and its control points are symmetry, so the symmetry button is in chosen status 
as follow: 

 

Fig. 2-88  

3、 User can modify the mode of current node which you need, now, we will explain the 
node editing in different modes: 

Ø Transition sharply 

When user edit one control point, another would not change. One side of the 
curve will change, another side will not. It will lead the transition of current 
node turn large. 

After add nod, the 
curve will distortion, 
it need to adjust. 
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Fig. 2-89  

Ø Transition smoothly 

When user edit one control point, another will keep in the same line with 
current node and change unsymmetrical. The curve of current node become 
more smoothness. 

 

Fig. 2-90  

Ø Transition symmetrically 

Control points and current node assume a line, and change symmetrically. So 
move one control point, another will follow to change under the node editing. 
Both curve of node will change by the same proportion at the same time. 

 

Fig. 2-91  

4、 Edit curve directly 

User can modify curve through mouse to click one curve and drag it. 

 

Fig. 2-92  
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It also has three modes of control point editing when edit curve. The above figure is transition 
symmetrically, because when drag one curve, three curve follow to change, and change 
symmetrically. 

We will explain how the three modes switch each other. 

 

Fig. 2-93  

If users want to edit that curve which arrowhead point. Base on the characteristic of Bezier 
curve2, the current curve control by two control point, one is back control point of front node, 
another is front control of next node. So the edit mode of these two should be modified. 

If the edit mode of front node is “transition sharply”, when edit this curve, the front curve will 
not follow to change. 

 

Fig. 2-94  

Other modes are the same as it. 

 

 

Note 

This software support two Bezier curves: 

Bezier1 is just need to confirm the point when drawing, then account the Bezier curve 
automatically. 

Bezier2 is that through adjust the two control point of node to modify Bezier curve 
when drawing. 

 

2.2.2.10 Text 

How to draw: Click button in the drawing toolbar to enter the text drawing state, and 
press the left key of mouse in drawing area, a default text “TEXT” will then be displayed in the 
current position. 

Text Property: Select the text and the property will be displayed in property area, where user 
can set different values to adjust the selected text. 
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Fig. 2-95  

Distance (%): Set the space between words, unit in %. 

Distance between words= Height of a single word *distance (%) 

 

Fig. 2-96  

Array manner (mm): Line and arc array are supported. The default is line array. To array the 
words in arc circular form, click “Arc” option and set the radius of arc array in “Circular arc radius 
(%)”, and then click “Apply” to confirm. Radius of arc array= Height of a single word*circular arc 
radius (%). 

Such as arraying “0123456789” as circular arc: 

 

Fig. 2-97  

Radius of arc arrangement 

Height of a single word 
Distance between words 
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Text: Content of text 

Font: Set the font, font style, effect, etc. of the text. 

 

2.2.2.11 Drill 

How to draw: Click  button or use the shortcut F11 to enter the perforation drawing 
state, and click in the working area to draw: 

 

Fig. 2-98  

Property settings: Select the Perforated graphics and the property will be displayed in 
property area, where user can set the time delay (ms) to adjust the perforating time. 

  
Fig. 2-99  

Note 

Multiple perforated graphics can be selected and configured with the same 
time delay. 

 

2.2.3 Edit 

The following several operations are provided, namely Copy, Delete, Cut, Paste, and Replicate. 

 

2.2.3.1 Copy (Shortcut: CTRL+C) 

Select the graphics that needs to be copied and then click button in figure editing toolbar 
or press shortcut CTRC+C, or right click the mouse to pop up menu as:   
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Fig. 2-100  

After pasting, the system will generate a new graphics with the same attribute as original at 
the same position. 

 

2.2.3.2 Delete (Shortcut: Delete) 

Select the graphics that needs to be deleted, and then press the shortcut “Delete” key to 
delete or right click the mouse to pop up menu as: 

  
Fig. 2-101  

Click “Delete (D)” to delete. 

You can select figures in drawing area or from tree control in graphics list, and press “Delete” 
key to delete the figures. 

 

2.2.3.3 Cut (Shortcut: CTRT+X) 

Select the graphics that needs to be cut, and then press button or the shortcut “CTRC+X” 
to cut, or right click the mouse to pop up menu as: 

  
Fig. 2-102  

 



SmartCarve43 software manual 

-54- 

2.2.3.4 Paste (Shortcut: CTRL+V) 

After the copy or cut of graphics, you can click button in figure editing toolbar or shortcut 
CTRL+V to paste the graphics. After pasting, the system will generate a new graphics with the same 
attribute as original at the same position. 

 

2.2.3.5 Cut Out (Shortcut: CTRL+U) 

The clip function is only applicable to curve for the moment. For other graphics (such as 
rectangle, polygon, and ellipse), users can right click them and choose “Convert to line” for 
conversion. 
Ø Upon choosing the curve, you may perform the following four operations to enter 

clipping state: click  in the toolbar, use the shortcut CTRL+U, click “Clip” in the 
right-click menu, or click “Edit”->”Clip” in the main menu. 

 

Fig. 2-103  

 
Fig. 2-104  

Ø How to clip 

Fix two points on the selected primitive to clip. (These points can be the nodes or midpoints of 
the selected primitive or any one point on a certain line segment). 

How to show the clipping feature interface 

Follow the steps below to fix the coordinates of the two points. 

After accessing the clipping mode, move the mouse until the cursor touches the primitive but 

not a node, and the cursor changes to the shape of scissors  while a point shows up on the 
selected primitive. Click to fix the point.When the cursor touches the node of the selected primitive 
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or the midpoint of a certain line segment, it changes to the shape of . Then, click to fix the 
point. 

 

Fig. 2-105 Before edit 

 

Fig. 2-106 Editing  

 

Fig. 2-107 After edit 
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2.2.3.6 Clone 

Select the graphics that needs to be replicated and right click the mouse in drawing area to 
show a menu as: 

 

Fig. 2-108  

Select “Replicate (E)” and a dialogue box shows up: 

 
Fig. 2-109  

Rows: Set how many figures can be replicated in each line. 

Columns: Set how many figures can be replicated in each column. 

Rows interval: Set the space between figures in each line, unit in mm. 

Columns interval: Set the space between figures in each column, unit in mm. 

Take drawing a circle as an example, set it as 3 lines and 3 columns, the line spacing and 
column spacing are both 2mm: 

 

Fig. 2-110  
 

Column spacing 2mm 

Line spacing 2mm 
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2.2.3.7 Undo (Shortcut: Ctrl + Z) 

After drafting a figure or modified parameters of figure, you can press shortcut Ctrl+Z or click 

 to cancel the current operation and return to the previous operation. 

 

2.2.3.8 Re-do (Shortcut: Ctrl + Y) 

After the canceling, you can press shortcut Ctrl + Y or click button to re-do and return to 
the next operation. 

 

2.2.3.9 Alignment 

In toolbar: 

 

Fig. 2-111  
There are several manners of graphics alignment: Put to origin, Align left, Align right, Align top, 

Align bottom, Align center, Make same width, Make same height, Make same size, Space across, 
and Space down. 

When users choose multi-figures, there is a figure will be circled by a black dashed box in the 
drawing area. This figure is the reference figure, the align operation is base on this figure. 

 
Fig. 2-112  

User can press and hold the “shift” key and click the any one of chosen figure to change the 
reference figure. 

 
Fig. 2-113  

Put on origin: Put on the selected or all graphics to the origin as follow: 
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Fig. 2-114 All graphics put on origin 

 
Fig. 2-115 Selected graphics put on origin 

 

Left: Allow the selected graphics to align at left side of enclosing rectangle 

 
Fig. 2-116  

Right: Allow the selected graphics to align at right side of enclosing rectangle 
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Fig. 2-117  

Top: Allow the selected graphics to align on top of enclosing rectangle 

 
Fig. 2-118  

Bottom: Allow the selected graphics to align at bottom side of enclosing rectangle 

 
Fig. 2-119  

Center: Allow the selected graphics to get close to the center of enclosing rectangle 
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Fig. 2-120  

Make same width: Set the same width between selected graphics and reference graphics. 

 
Fig. 2-121  

Make same height: Set the same height between selected graphics and reference 
graphics. 

 
Fig. 2-122  

Make same size: Set the size of selected graphics same as the reference graphics. 
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Fig. 2-123  

In addition, additional different manners of alignment are provided. In toolbar: 
 

 Distribute rows evenly: The selected graphics is horizontally aligned with equal space in 
the enclosing rectangle. 

 Distribute lines evenly: The selected graphics is vertically aligned with equal space in the 
enclosing rectangle. 

For example, distribute rows evenly: 

 
Fig. 2-124 Before 

 
Fig. 2-125 After distribute rows evenly 

 

2.2.3.10 Prev. Graph 

This function mainly use to looking for prev. graph from selected graphics. If there is not any 
graphics be selected, you will look for the first figure in current list when you click this menu. Its 
keyboard shortcuts is “CTRL+UP”. This function also reflect the working gradation of current 
graphics. 

 

2.2.3.11 Next Graph 

This function mainly use to looking for next graph from selected graphics. If there is not any 
graphics be selected, you will look for the first figure in current list when you click this menu. Its 
keyboard shortcuts is “CTRL+DOWN”. This function also reflects the working gradation of current 
graphics. 
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2.2.4 Modify 

Functions available for the moment include: Mirror, Fill, Coordinate system, Move, Rotate, 
Shear, Stretch, and Shift Array, Cutting starting point, and processing direction. 

2.2.4.1 Mirror 

Select the graphics, and click “modify” →”mirror” and right click the mouse to select “Mirror 
(M)”, A dialogue box pops up: 

 

Fig. 2-126  

X Mirror: Tick off this item to mirror the object horizontally basing on Y axis 

Y Mirror: Tick off this item to mirror the object vertically basing on X axis 

Tick off X mirror and Y mirror at the same time, the origin will be the benchmark for mirror. 

 

Fig. 2-127  Primitive graphics 

 

Fig. 2-128  After X mirror 

 

Fig. 2-129  After Y mirror 

 

Fig. 2-130  After XY mirror 

More function of mirror, please refer to 2.2.5.3. 

 

2.2.4.2 Fill 

Fill in the closed graphics as follows: 

A. Draw a graphics that can be filled (closed curve such as rectangle, ellipse, text, vector 
diagram, etc.). 
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B. Select the graphics and right click the mouse to choose “Fill” from the pop-up menu, and 
then a dialogue box shows up: 

 
Fig. 2-131  

Direction: For X unidirectional filling, it is filled from the left side of filling line to the right side 
(or from the right side to the left side) every time. For X bidirectional filling, it is filled from the left 
to right (or from right to left) first, and after that it jumps to the right (or left) side of the next 
filling line and starts the laser to scan. This operation is repeated until the end of the filling. 

Likewise, for Y unidirectional filling, it is filled from the top of filling line to the bottom (or from 
the bottom to the top) every time. For Y bidirectional filling, it is filled from the top to bottom (or 
from bottom to top) first, and after that it jumps to the bottom (or top) of the next filling line and 
starts the laser to scan. This operation is repeated until the end of the filling. 

Scan precision (dpi): Set the space between filled lines to control the spacing of filling, unit in 
DPI and is expressed as line/inch. The smaller the value is set, the bigger the space between lines 
when scanning would be. The larger the value is set, the closer the space between lines would be. 

Ascent (mm): If a value is set here, the edge of carved figure would then have gradient. 
Generally, the gradient is started from the periphery of line. The smaller the value is, the steeper 
the gradient would be. There is no gradient when the value is 0. 

 
Delete contours: whether to delete the original graphics. 

 
Fig. 2-132  Before filling 

 

Fig. 2-133  After filling 

 

2.2.4.3 Coordinate 
This software is capable of switching the coordinate system. Right click the mouse in drawing 

area, and select “Coordinate system” from the pop-up menu or select “Modify (M)” -> 
“Coordinate system (C)” from the menu bar: 

 
Warm 

1. The minimum light intensity cannot be equal to the maximum light intensity. If the 
minimum light intensity=maximum light intensity, there would be no gradient. 

2. The filled layers are usually for engraving, and the speed is different from cutting 
speed; therefore, it is recommended to set the filled graphics and cutting graphics in 
different layers. 
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Fig. 2-134  

The coordinate point can be set as left up, right up, or left down, right down, which is taken as 
the origin of coordinates. Please select the right option according to the machine. 

 
Fig. 2-135  

The result is shown as follows: 

 

Fig. 2-136  left down right up 

 

Fig. 2-137  Right down left up  

The meaning of each option: 
Left down: Origin of coordinates is at bottom left, and is engraving and exporting toward the 

upper right when operating. 
Right up: Origin of coordinates is at upper right, and is engraving and exporting toward the 

bottom left when operating. 
Right down: Origin of coordinates is at bottom right, and is engraving and exporting toward 

the upper left when operating. 
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Left up: Origin of coordinates is at upper left, and is engraving and exporting toward the 
bottom left when operating. 

For example: Origin of a machine is at upper right, click “ right Up” in the dialogue box of 
coordinate system, and the interface will display the coordinate system as shown in Figure 2-138. 

The following is the figured diagram of machine (top view); the origin of machine is 
corresponding to the origin of coordinates at the upper right. 

 

Fig. 2-138  

 

2.2.4.4 Close Curve 

Close open curves. 
Ø Select one or more open curves, and click “Modify (M)”-> “Close” in the main menu, the 

“Close” item in the right-click menu, or the  icon in the toolbar to close the curve. 

  
Fig. 2-139  

 

Fig. 2-140  Before closing       After closing 

 

Size of working 

area Current position of laser 

head 

Origin of machine 
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2.2.4.5 Link Line 

Link line is used to link curve which has similar node to a new curve, its precision lie on“ link 
precision “ of “setting”( refer to software scheme) 

For example, draw two straight line, one point of one straight line and another point of 
another line are superposition. Then select these two line, right click “link line” or click “link line 

“ of “modify” or click in the toolbar to link line. They will become one line. 

 

Fig. 2-141 Before linking             after linking 

 

2.2.4.6 Convert Line 
Convert the selected figure into line: The cutting starting point and processing direction can 

be changed only when the figure has been converted to line. 

 
Fig. 2-142  

 

2.2.4.7 Convert Dashed 

Convert the selected figure into line: supported line, rectangle, regular polygon, ellipse, Bezier 
and text. 

Click “modify” →”convert dashed” or click “convert dashed” in the right click menu, a dialog 
box will pop up: 
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Fig. 2-143  

 

Fig. 2-144  

Blank length: the blank between line and line as L2of above figure. 

Dashed: tick this item, convert current curve into dashed. 

Segment length: the segment length of dashed as L1 of above figure. 

Drill: drill the above segment of dashed into drilled figure. 

Drill time: the lighting time. 

Such as an ellipse (width is 13mm, height is 5mm) convert into the dashed figure which the 
blank length is 1mm and the segment length is 1mm as follow: 

 

Fig. 2-145  

After drilling as follow:  

 

Fig. 2-146  
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2.2.4.8 Curve Starting Point and Direction 

The curve starting point and direction of graphics can be set via software. For example, draw a 
graphics and select in menu bar “Modify (M)”-> “Convert to line”. After that, select and double 
click the graphics, a red arrow will show up, indicating the curve starting point and the direction: 

 

Fig. 2-147  

You can right click the mouse at the red arrow to set the reversal processing, or on the other 

nodes to set the starting point of curve, while  will show up. After the settings, the 
figure is as follows: 

 

Fig. 2-148  

If the selected figure is closed figure, the set start function is also supported. Right click the 
mouse, while the following menu will show up: 

 

Fig. 2-149  

Select “set start” item, the red arrow will show at the current position of new start point as 
follow: 

 

Fig. 2-150  

 

2.2.4.9 Shrink and Expand  

Shrink and expand is mainly shrink and expand the original graph for opposite size, the size is 
the following interval. Different lasers may give out spots in different size after focusing. 

To compensate: 
Ø Choose one closed curve, click “Modify (M)”->”Shrink and Expand” in the main menu or 

“Shrink and Expand” in the right-click menu to pop up the Shrink and Expand window as 
the following picture shows: 
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Fig. 2-151  

Interval (um): Set the interval of shrink and expand, the unit is um.  

Shrink/Expand: Select to stretch the curve shrink or expand. 

 
Fig. 2-152  

Delete original graph: Tick to delete the original figure. 

Note 

The diameter compensation generates dimmed figures as the original, 
which will not be processed when being outputted. 

 

2.2.4.10 Leadin /Lead Out Line 

Leads are mainly applied to high power laser or high precision processing industries. 

If no leads were added, match points would appear at the start position when processing 
closed figures, thus producing nonconforming products. This is because the engine is still speeding 
up when laser beams are given out at the start position. 

After adding leads, a distance will be left for the engine to speed up before processing starts. 
In this way, the match point problem can be solved. The distance is referred as a lead. 

There are two kinds of leads: leadin and lead out. 

The feature is only available for closed curves for the moment. 

To set parameters of the lead: 
Ø After choosing the closed curve, click “Modify (M)”->”Add lead” in the main menu or “Add 

lead” in the right-click menu to pop up the lead adding window as shown below:  



SmartCarve43 software manual 

-70- 

 
Fig. 2-153  

Overlap length (mm): When processing closed figures, processing are enabled and ended at 
the start position, which will result in a different effect at the starts. Solution: Set a point instead 
of the start for processing. This is the work of over-cutting length.  

Lead In/Out: 

Lead In length (mm): Provide a length for the engine to speed up. 

Lead Out length (mm): Provide a length for the engine to speed down. 

Auto compute angle: 

Tick to enable the software to compute the angle of lead in/out angle automatically. Users can 
also set the lead in/out option. 

 
Fig. 2-154  

Deselect indicates that users can configure the lead in/out angle separately as below: 

  
Fig. 2-155  

Click “Ok” and you can find another two line segments appear on the original figure. See the 
figure below. 
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Fig. 2-156  
 

2.2.4.11 Set Curve Precision 

Different processing technology requires different processing data. Precision demanding 
industries require high precision data after processing, while other industries not. The curve 
precision feature in the system is compatible with the two processes above. 

To set the precision: 
Ø Cancel the selected graphics, and click “Modify (M)“->”Set curve precision” in the main menu 

or the ”Set curve precision” item in the right-click menu to pop up the corresponding setup 
dialog box shown as below: 

 
Fig. 2-157  

 
Fig. 2-158  

Curve Precision (um): Refers to the minimum point-to-point spacing. The smaller the value is, 
the higher the precision is. The spacing ranges from 20 to 10000 in um. 

The figures below are screenshots of curve converted ellipse in same size but different 
precision. Different effect after conversion of curve can be found. 
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Fig. 2-159  Curve precision: 20um 

 

Fig. 2-160  Curve precision: 2000um 

In addition, you can set curve precision at “config” interface, please refer to 2.2.9. 

 

2.2.4.12 Optimize Path 

Cancel the selected graphics, and click “Modify (M)” -> “Optimize Path” in the main menu or 
the “Optimize Path” item in the right-click menu to pop up the corresponding setup dialog box 
shown as below: 

 

Fig. 2-161  

Two optimization modes are available: 
² The shortest path 

As the special situation of “Subarea optimization”, the height and width are 200mm. 
² Optimize Subarea  
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Fig. 2-162  

The subarea works like a monitor to horizontally scan the current working are from the 
processing start point. When the graphics is entirely located in the scan range, output the primitive 
for processing. Otherwise, enlarge the display area continuously. The processing sequence depends 
on the order that the graphics enter the area. 

The height and width of the subarea correspond to that of the monitor. 

Start point of processing: Starting coordinates corresponding to path optimization. 

Refer to the following screenshots for details about subarea optimization: 
² Suppose the working area is 600*400mm, now there is a 80*80mm square cloning into 5 

rows * 7 columns, as the following picture shows: 

  

Fig. 2-163  
² During path optimization, the width and height of the subarea is set to 100*100mm and 

the bottom left corner is set as the start point for processing. Now, it seems that a 
100*100mm rectangle is continuously moving from left to right, as the following picture 
shows: 
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Fig. 2-164  

² The rectangle enclosed in the red one is the first graphic to be output. Upon continuously 
moving, the red rectangle is enlarged to 200*100mm, as the following picture shows: 

  
Fig. 2-165  

² Now another graphic enters the red area and will be the second primitive to be output, 
and so on. After finish scanning the first row, it directly accesses the next line. 

  
Fig. 2-166  

The sequence for processing graphics depends on the order to enter the red area. The arrows 
above indicate the moving direction of subarea, which complete until the entire working area is 
scanned. 
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When optimizing, large data may lead the optimize time over long. If users want to end the 
optimize, click the “cancel” button as following figure: 

 

Fig. 2-167  

 

2.2.4.13 Convert Drill to Small Circle  

The system supports the conversion of perforated graphics to small circle. 

Select one or more perforated graphics, and click “Modify (M)” -> “Drill to small circ” in the 
main menu or the “Drill to small circ” item in the right-click menu to pop up the corresponding 
setup dialog box shown as below:  

  
Fig. 2-168  

Circle radius: Refers to the radius of small circles converted. It ranges from 100 to 10000 
microns. 

Click “ok” after setting the small circle radius, the selected perforated graphics will drill to 
small circle. All perforated graphics of current figure will drill to small circle under the perforated 
graphics have not been selected. 

 

2.2.4.14 Convert Small Graph to Drill 

If users need to process these graphics, they can convert them to perforated to output for 
processing. 

Select one or more small graphics, and click “Modify (M)” -> “Small graphics to drill” in the 
main menu or the “Small graphics to drill” item in the right-click menu to pop up the dialog box for 
you to set the time delay for perforation, as the following picture shows: 

 

Fig. 2-169  
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Click “OK” after setting drill dalay, the selected graphics will drill. The system will make all the 
small graphics accord with request to drill if the graphics have not been selected. Wether a 
grahpics accord with small graphics or not, it rest with “small graph to drill precision” of “ config” 
interface. Only the graph less than the precision, it can convert small graph to drill. Otherwise, this 
function is noneffective. 

 

2.2.4.15 Group/Scatter 

With “Group” function, several selected graphics can be combined into a group. The operation 
for the group is equal to all the graphics. Such as move, rotate, mirror, etc. You can choose “Group 
(G)” option to form these figures into a new integrated figure. 

With “Scatter Group” function, you can break the selected combined diagram into several 
figures. 

Ø Select several figures, click ”modify” →”group” in the main menu or click the in the 
toolbar or right click the mouse to group. 

 

Fig. 2-170  

 

Fig. 2-171  Before group 
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Fig. 2-172  After group 

How to scatter group: 

Ø You can choose “Scatter” option or click button or right click “scatter group” to 
break the selected combined diagram into several figures. 

 

Fig. 2-173  
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Fig. 2-174  Before scatter group 

 

Fig. 2-175  After scatter group 

 

2.2.4.16 Convert Array and Leftover 

The array conversion functions as cloning. The only difference lies in that the columns and 
rows are calculated automatically by the system for conversion. For double laser heads, they are 
displayed in the same way on the screen but different in processing. The system automatically 
works out the spacing between the two heads, and a column of data will be completed by two 
laser head, greatly enhancing processing efficiency. 

The “Scatter” item works to separate the entire graphics in the array, similar to the function of 
“Break”. 

To convert to array: 
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Ø Select one or more graphics, and click “Modify (M)” -> “Convert Array” in the main menu 

or click in the toolbar or the “Convert Array” item in the right-click menu to convert 
to arrayed graphics, as the following picture shows: 

 
Fig. 2-176  

 
Fig. 2-177  

The display of interface after conversion: 
² The working area will be filled with arrays converted from graphics, as the following 

picture shows: 
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Fig. 2-178  

² The display of graphics list: The graphics of one array are displayed in the tree structure, 
and the corresponding attributes are displayed in the Attribute bar, as the following 
picture shows: 

 
Fig. 2-179  

As seen from the picture above, the common properties in the array’s properties are dimmed, 
indicating that arrayed don’t support editing features like moving, rotating, shearing, and 
stretching. 

Array properties: 

Rows/Columns: The default value, which is worked out by the system based on the current 
working area, can be modified as required. 

Choose the option on the right side of the rows, the picture is shown as below: 
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Fig. 2-180  

Then you can see the parameter had changed to Number, now the array number is 12, so user 
can set the number of the array to generate the main array data and sub array data. If user set the 
number is 23. 

 

Fig. 2-181  The rows of the main array is changed to 5 
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Fig. 2-182  Generate a new sub array of 1 rows and 3 columns. 

Rows/Columns interval: Defaulted as 0 and can be modified. Suppose both parameters are 
set to 10mm, the arrayed primitive will show as below: 

 
Fig. 2-183  

Rows mismatch: Defaulted as 0, indicating the misalignment between rows. Suppose the 
parameter is set to 50mm, the array will show as below: 
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Fig. 2-184  

Columns mismatch: Defaulted as 0, indicating the misalignment between columns. 
Suppose the parameter is set to 50mm, the array will show as below: 

 
Fig. 2-185  

Rows Mirror: To mirror the data of even rows according to the configured mirror axis. 
Suppose Y is checked for the parameter, the array will show as below: 
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Fig. 2-186  

Columns Mirror: To mirror the data of even cols according to the configured mirror axis. 
Suppose Y is checked for the parameter, the array will show as below: 

 
Fig. 2-187  

Through configuration of the parameters above, arrays can be transformed to the way that 
saves the most materials. Taking the graphics as an example, the currently configured working area 
is 920*920mm and the defaulted rows and cols are 3 and 4, the array can be set as follows to save 
the most materials. 
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Fig. 2-188  

The figure above shows the most economical way with 12 graphics placed and parameters set as: 
3 rows, 4 cols, -21mm column distance, and Y as the mirror axis. 

 

To scatter: 
Ø Select the arrayed graphics, and click “Modify (M)” -> “Scatter” in the main menu or the 

“Scatter” item in the right-click menu or click in the toolbar to scatter the array. 

 

 

Note 

Now we can use the shortcut key to adjust the row/columns interval and 
row/columns mismatch. 
At first, user must choose the array graphic: 
1) Press the key A and D to adjust the row interval; 
2) Press the key W and S to adjust the columns mismatch; 
3) Press the key SHIFT+ A/D to adjust the row mismatch; 
4) Press the key SHIFT+W/S to adjust the columns interval; 
5) Press the key F to set the distance to adjust the row/columns 

interval and row/columns mismatch, default value is 1mm;  
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Fig. 2-189  Before scattering 

 
Fig. 2-190  After scattering 

To cancel the array: 
Ø Select the arrayed graphics, and click the “Cancel” item in the right-click menu to cancel 

the array. 
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Fig. 2-191  Before cancellation 

 
Fig. 2-192  After cancellation 

 

The dual laser heads carry out processing after the distance between two laser heads is 
automatically worked out according to the column number of the array. After array conversion, the 

 
Warning 

Only one array graph is allowed in one document. 



SmartCarve43 software manual 

-88- 

figures may not fully fill the area due to the working area of machine, causing a serious waste. The 
system provides leftover conversion feature for users to save materials. 

 

Fig. 2-193  

About the application of leftover, please refer to 3.2. 

 

2.2.4.17 Convert to Light Guide 

This software support special drawing function for light guide processing, please refer to 3.1. 

 

2.2.5 Switch 

2.2.5.1 Move 

This can be done by mouse, or by setting the parameters in switching dialogue box. 

Ø Drag mouse to move 

The software allows users to use mouse to modify the figure directly. It is convenient and 
quick to operate. Draw a graphics, such as rectangle, move the cursor to cross mark in the center 

of rectangle when it will become a cross arrow sign , press and hold the left key to move the 
figure, and then the following interface shows up: 

 

Fig. 2-194  



SmartCarve43 software manual 

-89- 

Ø Use “switch” to move 

Click “Modify” ->“Switch” in the menu bar, click button, and a dialogue box will show up 
as follows: 

 
Fig. 2-195  

 
Fig. 2-196  

Horz (mm): refer to the position at X axis 

Vert(mm): refer to the position at Y axis 

Relatively position: 

Unchecked: The value set in “Position” is the absolute position in the working area. 

Checked: Move the figure a distance correspondingly to a certain position of enclosing 
rectangle of graphics. 

The 9 positions of enclosing rectangle of graphics are center, upper left, left side, bottom left, 
bottom side, bottom right, right side, and upper right, respectively. If relative position is set as 
center, when you click “Apply” button, the figure will be moved to the center a certain distance, 
which is set in “Position”. 

Apply to copy object: Apply the parameters set above to the copy object of this graphics. 

Apply: Apply the parameters set above to the selected graphics. 
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2.2.5.2 Rotate 

Rotation can be done by mouse, or by setting the parameters in switching dialogue box. 

u Use mouse to rotate the graphics 

When the graphics is selected, click it again to enter the following state: 

 
Fig. 2-197  

Move the cursor to the compound bending arrow (any corner of the four corners), press and 
hold the left key of mouse to move and rotate the figure. 

 
Fig. 2-198  

User can also move the rotation center, and the figure will rotate around the rotation center 

after that. When rotating, the center will show as . 

 
Fig. 2-199   

u Use the Switch dialog to rotate the graphics 

Click “Modify” ->“Switch” in the menu bar, click button, and a dialogue box will show 
up as follows: 

Compound bending 

arrow 
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Fig. 2-200  

Angle: Set the rotation angle of graphics. 

X (mm): refer to the position at X axis 

Y (mm): refer to the position at Y axis 

Relatively center: 

Unchecked: The value set in “Position” is the absolute position in the working area. 

Checked: Rotate the figure at an angle correspondingly to a certain position of enclosing 
rectangle of graphics. 

The 9 positions of enclosing rectangle of graphics are center, upper left, left side, bottom left, 
bottom side, bottom right, right side, and upper right, respectively. If relative position is set as 
center, when you click “Apply” button, the figure will be rotated at a certain angle around the 
center. This angle is set in the above parameters. 

Apply to copy object: Apply the parameters set above to the copy object of this graphics. 

Apply: Apply the parameters set above to the selected graphics. 

u Two-position rotating 

Selected the graphics which is need to do the rotation, and right clicked the 
menu ”Two-position rotating” or press the shortcut key “CTRL+R” to switch this mode. 
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图2-90  
² At first, user need to choose the first point of the selected graphics, and this point as the 

rotation center. 

 

图2-91 Press the left mouse button to select 
² Choose the second point of the selected graphics. 
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图2-92 Choose the second point  

After choose the second point, then the angle of the line relative to the horizontal line would 
be calculated, and rotate the graphcis automatically according the angle.  

 

图2-93  

 
Note 

In the two-position rotating mode, user can only choose the point which is the node of the selected 

graphics.  

2.2.5.3 Mirror 

Ø Select the graphics, click “mirror” in the “modify” of main menu or right click the mouse to 
select “Mirror (M)”: 

 
Fig. 2-201  

The dialogue box will pop up: 
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Fig. 2-202  

X Mirror: Tick off this item to mirror the object horizontally basing on Y axis 

After the X mirror  
Fig. 2-203  

Y Mirror: Tick off this item to mirror the object vertically basing on X axis 

 

After the Y mirror 

 
Fig. 2-204  

Note: The above mirror operations are done on the condition that the graphics is selected. If 
the graphics is not selected, it is mirrored basing on the central line of working area as shown 
below: 

 

 

 

Fig. 2-205  

Ø Use “switch” to mirror: 

Click “view” →”switch” in the main menu, then click button to enter parameter 
interface as follow: 

Working area 

After the 

 X mirror 

After the 

 Y mirror 
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Fig. 2-206  

: Click this button to mirror the selected graphics basing on X direction. 

: Click this button to mirror the selected graphics basing on Y direction. 

: That point is the reference point when mirror. 
 

 

2.2.5.4 Stretch 

Stretching operation can be done by mouse, or by setting the parameters in switching 
dialogue box. 

u Still take a rectangle as an example: 

 

Fig. 2-207  

Move the cursor to the black spot around the rectangle when it will become an arrow mark, 
you can then press and hold the left key to stretch the figure. 

Up switching 
Upper left switching 

Left switching 

Bottom left switching 

Bottom switching 

Bottom right switching 

Right switching 

Upper right switching 
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Upper right switching: Switch the figure towards the upper right 

Right switching: Switch the figure rightwards 

Bottom right switching: Switch the figure towards the bottom right 

Bottom switching: Switch the figure downwards 

Bottom left switching: Switch the figure towards the bottom left 

Left switching: Switch the figure leftwards 

Upper left switching: Switch the figure towards the upper left 

u Click “Modify” ->“Switch” in the menu bar, click button, a dialogue box will show 
up as follows: 

 

Fig. 2-208  

Size: 

X/Y (mm): the length/width of current selected graphics. 

: Set the number of X/Y without changing by the geometric proportion. 

: Press it, the number of XY will change by the geometric proportion, the Y number will 
change when modify X number. 

: These options are the reference sides when switching. 

 

Note 

Press and hold “Ctrl” key can stretch with geometric proportion. 
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2.2.5.5 Shear 

Shearing can be done by mouse, or by setting the parameters in switching dialogue box. 

u When the graphics is selected, click it again to enter the following state: 

 

Fig. 2-209  

Move the cursor to the bi-directional straight arrow (any side of the four sides), press and hold 
the left key of mouse to move and shear mapping the figure. 

 

Fig. 2-210  Up-down shear 

 

Fig. 2-211  Left-right shear 

 

u Click “Modify” ->“Switch” in the menu bar, click  button to enter the parameter 
interface as follows: 

 

Bi-directional straight arrow 
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Fig. 2-212  

Horz: refer to the degree of shear at the horizontal direction. 

Vert: refer to the degree of shear at the vertical direction. 

: Current reference side when stretching, this side of selected point would not stretch. 

2.2.6 Layer 

 
Fig. 2-213  Interface of layer list box 

Layer can be taken as a kind of processing technology. A layer is equivalent to a processing 
technology. There are several kinds of processing parameters in a layer. 

For example in a figure, some places need to be cut deeper and some places need to be cut 
shallower, this can be done easily with the help of layer settings. 

As many as 256 layers are supported. Layer list, layer parameter and work parameter setting 
area are included. 

2.2.6.1 Layer List 

  
Fig. 2-214  

As many as 256 layers are supported. In the layer list, there are items like ID, Color, Priority, 
process, and visible. 

Blue indicates the 

checked layer 

Gray indicates 

the current 

default layer 
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In the layer list, the blue color indicates the checked layer, and the gray color indicates the 
current default layer. When drafting the figure, the figure is at the current default layer. 

Color: Color of the layer, click this item to pop up dialogue box of color setting, user can 
choose any color to set it as the layer color: 

 

Fig. 2-215  

Priority: Set the processing sequence of current layer from grade 1~256. Grade 1 is the 
highest priority, and grade 256 is the lowest priority. 

Process: Set whether the figure data of the current layer is involved in the processing. 

Visible: Set whether the figure data of the current layer is displayed in the drawing area 
Select a layer in the layer list and right click the mouse, a menu will pop up as follows: 

 

Fig. 2-216  

Ø Apply to pick object: after click this item, switch the layer number of selected object in 
the current drawing area to opposite layer ID number of current right click point. 

Ø Apply this layer to all layer: after click this item, system will copy the layer parameters of 
current right click point to other layers. 

Ø Set default pen: If this option is selected, all figures drafted in the drawing area belong to 
this layer. 

Ø Parameter library: parameter library is used to save the current parameter which user 
set, please refer to next section: 

 
Warm 

The relation between layer process and graph process: 

ü When process of layer parameter setting “no”, no matter how to set the 
process of graph, all graphics of this layer are not processing. 

ü When process of layer parameter setting “yes”, if the process of graph 
setting “no”, the current graph will not process. 

ü When process of layer parameter setting “yes”, if the process of graph 
setting “yes”, the current graph will process. 



SmartCarve43 software manual 

-100- 

 

 

2.2.6.2 Parameter Library 

 

Fig. 2-217  

Ø Save layer parameter: save current process parameter to a new file, current layer 
parameter file can be changed. 

Ø Delete select parameter: delete the selected parameter file of current list. 

Ø Apply to default: revert the process parameter of current layer to default parameter (the 
primitive parameter) 

Ø Load: click this button to load all the parameter of current selected file into process 
parameter of current layer. At this moment, “parameter name” will show current 
parameter file name. 

 

2.2.6.3 Layer Parameters 

 

Fig. 2-218  

Layer name: Each layer has the exclusive number, cannot be modified. 

Processing media: base on different users, the processing media can be selected. When 
choose laser to process, this parameter will be set “laser head”. When choose pen to process, this 
parameter will be set “pen”. 

Only support 3rd controller. 

 

2.2.6.4 Work Parameters 

u Work parameters of No.1.1 controller. 
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Fig. 2-219  

Work vel: Set the speed of single-axis motion when the machine is working 

Min. power(%): The minimal value of laser when processing (0~100%) 

Max. power (%): The maximum value of laser when processing (0~100%) 

The maximum light intensity should always larger or equal to the minimal light intensity. In 
case of the similar speed, the larger the light intensity is, the deeper the engraving would be. 

u work parameter of Third Controller 

 

Fig. 2-220  
Work power: Set the amount of laser energy during the processing 

Corner power: Set the minimal (cornering) edge lining energy when cutting 

Work vel: Set the speed of cutting 

Work acc: Set the acceleration during the processing 

 

2.2.7 Virtual Printer Input 

Data (vector diagram, bitmap, text, etc.) from all kinds of software (such as CorelDraw, and 
AutoCAD) can be transferred to SmartCarve with the help of printing function of the software via 
the Virtual Printer. It is simple and quick, getting rid of the format conversion and import 
operations. Please refer to virtual print input of chapter3 about the particular method. 

 

 
 
 

Note 

The light intensity will influence the depth of engraving, which is also related to 
the power of laser, model of main board, speed value and DPI settings in parameter 
settings.  

ü If the power is set as the same, the faster the speed is, the shallower the 
engraving would be. On the contrary, the slower the speed is, the deeper 
the engraving would be. 

ü If the speed is set as the same, the greater the power is, the deeper the 
engraving would be. On the contrary, the smaller the power is, the 
shallower the engraving would be. 
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2.2.8 Export 

2.2.8.1 Net Transfer 

Net transfer only support No.3 controller. Application of network transmission function: 

After saving the drafted figure as *.ymd file or exporting the parameters as *.ini file, click the 

network transmission button in toolbar, and the following dialogue box will pop up: 

 

Fig. 2-221  

Steps to download files to machine: 

u Link the network. If the network is successfully Linked, network Linked information will be 
shown in the network status area. 

u Set the IP address. It is default as “192.168.1.8”. The IP of machine should also be set as this 
value. 

u Change the file catalog in “Local Dir”. In the left file list, there show the figure data files and 
parameter files. 

u Select the file(s) and click the right double-headed arrow to download them to machine. 

Steps to upload files to computer: 
u After Linking to the network, the current files on machine will be shown at the right file list. 

u Select a file and click the left double-headed arrow to upload it to the current catalog on the 
computer. 

2. Set the IP address 

Network status 

message 

4. List of files on computer List of files on machine 

5. Download 

data to 

machine 

Upload machine 

data to computer 

1. Connect the network 

3. Change 

the file 

catalog 
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2.2.8.2 Carve Output 

When all figure data are ready, it is time to export them to machine for operation. Click  
in the toolbar, or right click the mouse in drawing area. A dialogue box will show up as follows: 

  
Fig. 2-222  

Clone row, clone column: 

Figure data can be exported in multi-line or multi-column way. The default is 1 line and 1 
column. 

Row interval (mm), Column interval (mm): 

Set the spacing between figures when exporting figures with several lines and columns. 

Estimated time: 

It is the time estimated to process the current graphics according to the customized 
processing speed. 

Feeding count: 

It is applicable to automatic feeding equipment. The default value is 0, and the machine cuts 
for one time. Cutting times of machine=Feeding times+1. 

Feed length (mm): 

It is the length of feeding at one time, user can set a value as required. 

Origin mode: 

 
Fig. 2-223  

Anchor point: It is a positioning point previously set, to which the machine will return and 
start engraving and cutting. The origin of coordinates in the drawing area is corresponding to the 
set positioning point of machine. 
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Current point: The machine will start engraving and cutting from the current position of laser 
head. The origin of coordinates in the drawing area is corresponding to the current position of laser 
head. 

As shown in the following diagram: 

 
Fig. 2-224  SmartCarve4 drawing area 

The final output effects of above options are as follows: 

 

Fig. 2-225  

Rotate diameter: To set the column diameter for engraving, used for setting the engraving 
machine. 

Cut edge: Allow you to set the power for cutting edge. The machine will use the value to trim 
frames. 

Vel: To set the speed for cutting edge. 

Power: to set the power for trimming. 

Origin output 
Anchor point output 

Current point output 

Origin of coordinates in the 

drawing area 

Working size of machine 

Current position of laser head 

Origin of machine 
Anchor point 
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Carver Out: 

Start to export to the machine. When you click the OK button, there will be a progress 
indication in the status bar of the software. 

 

Fig. 2-226  
Cut Edge: Start task for cutting edge. 

Cancel: Exit 

 

2.2.8.3 Jog Control 

Jog control is used to control No.1.1 controller. This function is effective when the machine is 

No.1.1 controller. Click button in the toolbar or press “CTRL+H” or click “Jog Control” in the 
tools menu as follow: 

 

Fig. 2-227  

A dialog box will pop up: 

 

Fig. 2-228  

Ø Axis: select the hand move axis, X、Y、Z、U、V、W and material axis. 
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Ø Relatively: click relatively, setting the relatively offset, the default is 0, the unit is mm. 

Ø Absolutely: click absolutely, setting the end position, the default is 0, the unit is mm. 

Ø Power: tick “laser on”, setting the laser on power, the default is 0, the unit is %. 

Ø Speed: setting the move speed, the default is 0, the unit is mm/s. 

Click “run” to take hand move after setting. 

 

2.2.8.4 Cancel Filter Operation 

The feature is only available after the filter has been enabled. 

When an operation takes a long time, the software enters the suspended state, resulting in 
failure to perform any other operation unless the current operation is complete. Therefore, the 
system provides such a feature that is designed to solve the problem. 

If users do not want to proceed upon the operation of some filter, just click the  button 
to quit. 

The system only allows one filter to work at the same time for the moment. 

Filter operation includes Import File (like vector diagram and bitmap), Printer Input, Export 
(plt, ymd, oux, etc.). 

 

2.2.8.5 Machine Parameter Setting 

Please refer to its software manual about the correlative content of machine type of 
controller. 

No.1.1: please refer to “User Manual of NO.1.1 Control System” 

No.3: please refer to “User Manual of NO.3 Control System”  

No.4: please refer to “User Manual of NO.4 Control System” 

Auto feeding: please refer to “User Manual of Nest Cutting” 

Vision system type: “User Manual of Vision System” 

 

2.2.8.6 Path Simulation 

If you want to simulate the processing of figure on computer, you can click in toolbar, and 
the track simulation dialogue box will pop up: 
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Fig. 2-229  

During the simulation of figure processing, users can also perform the following operations on 
the keyboard: 

Right arrow key: increase the idle travel speed (the white part in the picture) 

Left arrow key: decrease the idle travel speed (the white part in the picture) 

Up arrow key: increase the processing speed (the green part in the picture) 

Down arrow key: decrease the processing speed (the green part in the picture) 

Space key: Pause or keep on the track stimulation operation 

R key: Restart the track stimulation 

ESC: Exit Engraving output 

Cut length (mm): show the info about cut path length. 

Space length (mm): show the info about space path length. 
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2.2.9 Config 

Click “tools” →”config” in the main menu or click button: 

 

Fig. 2-230  

Open the config interface, the config as follow: 

 

2.2.9.1 General 

 

Fig. 2-231  

Ø Unit type: the unit type when show coordinates and distance. Only support mm now. 

Ø Paste X (mm): the horizontal offset between paste figure and primitive figure. 

Ø Paste Y (mm): the vertical offset between paste figure and primitive figure. 

Ø Show grid: tick this item, grid will show in the drawing area. 

Ø Grid space: setting the space between of grid. 

Ø Redo/undo grade: redo or undo the operation, the higher grade is, the larger the memory 
consumption. Please set grade properly. 
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2.2.9.2 Color 

 

Fig. 2-232  

User can set the color of interface as follow: 

Ø Background: the background color of drawing area, click background box 

, the color chosen dialog box will pop up as follow: 

 

Fig. 2-233  

Select the background color, then click “ok” back to color setting main interface, then click ”ok” 
to finished. 

Ø Workspace: setting the color of workspace. 

Ø Grid: setting the color of grid. 

Ø Ruler: setting the color of grid. 

In addition, in “View (V)” option in main menu: 
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Fig. 2-234  

User can set whether to show grid and scale in the drawing area. 

 

Fig. 2-235  

 

2.2.9.3 Workspace 

 
Fig. 2-236  



SmartCarve43 software manual 

-111- 

Ø Show workspace: tick this item, show the working area( the rectangle box with shadow) 

Ø Show cross line: tick this item, show the cross line of center(origin coordinate line, the 
red dashed ) 

Ø Width (mm): Refer to the width of working area, or the working range of machine at 
X-axis direction. 

Ø Height (mm): Refer to the height of working area, or the working range of machine at 
Y-axis direction. 

User can regulate the width and height according to the processing scale of carving machine. 
Make the CMA1390 for example, user could fill in 1300 in width and 900 in height in the config 
dialogue box (unit in mm). The default is 1000mm*800mm. 

 

2.2.9.4 AutoSave 

AutoSave is used to save the figure which users draw automatically, the interface as follow: 

 

Fig. 2-237  

Ø Auto Save: AutoSave is effective when tick this item. 

Ø Time (minutes): the time of auto save, save current data to file “auto save.smc” in install 
directory at specified time space. When close the software singularly, user can open this 
saved file to resume data after restart the software. 

 

2.2.9.5 Move/Rotate 

User can move or rotate the figure through the keyboard, setting move or rotate distance. 
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Fig. 2-238  

Ø Nudge distance: press up/down/left/right key of keyboard to move the selected figure, 
figure move every time you press the key, the unit is mm. 

Ø Big nudge scale: press shift +up/down/left/right key to quicken the speed of moving 
figure. Base on nudge distance, multiply a coefficient. 

Ø Rotate angle: press ctrl+ left/right key to rotate the selected figure, figure rotate every 
time you press the key, the unit is degree. 

Ø Max num: when the select graph num is exceed this num, it’s only show the outline 
when do stretch or rotate operation. When the select graph num is lower this num, it will 
show the operation at real-time. 

 
Note 

Please set the right max num base on the computer instance, if set too big, 
it will affect the shown and deal speed when operating. 

 

2.2.9.6 Precision 

Precision is used to set the precision standard when dealing figure, different setting lead the 
different figure dealing effect. The interface as follow: 
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Fig. 2-239  

Ø Precision for conversion: When it is smaller than a certain value, the graphics can be 
perforated. The value, namely the precision for conversion of small graphics to 
perforated graphics, ranges from 10 to 10000 microns. 

Ø Curve precision: To set the curve precision for the software. 

Ø Link line precision: To set the link line precision for software. 

Ø Combine lines while import the file: the software can link the lines which is below the 
link line precision during import the vector file. 

Ø Smooth line: precision and velocity on both sides of the sliding block directions. Slider 
toward to right, the precision of software is not high when output graphics processing, 
which may lead to some arc shape when output; Slider toward to left, the precision of 
software will higher, but the processing speed will reducing; shown in the following 
figure: 

 

 

 

Fig. 2-240 The left one is precision processing state, the right one is velocity processing state 

2.2.9.7 User Manager 

User manager is used to manage the purview, three classifications: administrator, designer 
and worker, the interface as follow: 
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Fig. 2-241  

Ø Enable user: tick this item, user manager takes effect. 

Choose user and set the password. Click “modify password” button, the dialog box pop up as 
follow: 

 

Fig. 2-242  

Enter the new password in the password box and enter it again in the confirm password box, 
and then click “ok” to finish. 

2.2.9.8 Backlash  
This parameter only needs to be set in the No.1 controller, set the backlash of cutting and 

engraving process, backlash setting interface as shown below: 



SmartCarve43 software manual 

-115- 

  

Fig.2-194  Backlash table of No.1 controller 

The backlash is determined by the mechanical accuracy of the machine and the response 
speed of the laser. The movement of the machine is driven by the electromotor to drive the motor 
belt. When processing, since there is a certain degree of activity gap between the engagement of 
the tooth of the belt and the gear. As shown below, when clockwise, and reversal of the 
transformation occurs, the activity gap will affect the efficiency of the transmission, lag the 
transmission, then you need to set the backlash to resolve the problem of the machine's 
transmission lag. 

 
Fig.2-195   

When there is an active gap, the processing will appear as shown below: 

      

Fig.2-196 Left is the expectation of processing, the right is processing effect of transmission lag 

Activity gap 

Movement 
direction 
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2.2.10 Language 

The available languages are Chinese (Simplified), Chinese (Traditional), and English (US). To 
add a language, add the corresponding XML file into the “Language Settings”. 

 

Fig. 2-243  

At above figure, tick “English(US)” means that the current language is English. 

2.2.10.1 Language Setting 

Language setting supports a language loading manner to user. It will pop up a dialog box as 
follow: 

 

Fig. 2-244  

The left box show the language file of current system, user can export the language file of 
current system to anywhere of disk. 

You can find the language file of disk which selected from right box, and then load it into 
system list. A new language file will be added. 

Click  button and choose a disk list, the system will research whether the language 
file exist in the current list automatically. It will show by list if it exists as follow: 
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Fig. 2-245  

If there is a Czech file in the disk list, select it and click button, this file will be loaded 
into system list as follow: 

 

Fig. 2-246  

Click “exit” to exit “language setting” interface. 

A new language show in “tool” →”language” as follow: 

 

Fig. 2-247  
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2.2.10.2 Translate Tool 

 

Fig. 2-248  

Please refer to 3.4 about the translate tool and its language file making. 
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Chapter 3 Application Example 

3.1 Drawing Light Guide Graphics 

How to draw: 

1. Open software, draw a closed vector graph ( make a rectangle for example): 

 

Fig.3-1  

2. Select the rectangle and right click the mouse, then click “convert light guide” menu. 

 

Fig.3-2  

The setting interface of light guide will pop up as follow: 
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Fig.3-3  

SmartCarve 4 can create three modes for the light guide industry: line, sweep and grid. It can 
create arbitrary light guide graphics, design the graphics which enter light by one side, double sides, 
many sides. The explain of three modes of light guide are as follow: 

1) Line: The export graphics is speck, we can adjust the width of speck. The height of speck 
decided by the line of laser head. Working high speed, process speck uniformly, and the 
amount of producing data is small. It is apply to process the speck light guide of large 
area. The quality of speck depends on the stability of laser. 

2) Sweep: Also named carve, the export graphics is speck. The size, width and height of 
speck can be adjusted by software. Its working manner is similar to fill carve. All specks 
carved by laser repeatedly. This manner is inefficient, but high quality and good steady. 
Its DPI can be adjusted and produce the circle of arbitrary size. It is apply to process the 
speck light guide of small area. 

3) Grid: The export graphics is grid line or the straight line of X/Y direction. The process 
manner is drawing line by laser head. This manner process with high speed, but the data 
amount of graphics is small. The grid form can be designed by users. The quality of 
drawing line depends on the stability of laser. It is apply to process the grid light guide of 
arbitrary area. 

Now, will make example to the three modes of light guide graphics: 

 

3.1.1 Line 

The height of speck is decided by the distance between laser head and speck. The software 
can only set the speck change of width (height) and grads. The parameters setting as follow: 

Ø Speck width (mm): setting the reference height of speck. 
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Ø Width grads (mm): setting the width’s gradual change value row by row or column by column 
of speck. When setting above zero, the width increases long by degrees. When setting below 
zero, the width decreases short by degrees. When setting row grads, the width of speck 
changes row by row. When setting column grads, the width of speck changes column by 
column. 

Ø Up row interval (mm): setting the reference distance between row and row above the speck 
of horizontal reference line. 

Ø Up row grads (mm): setting the gradual change value of row distance above the speck of 
horizontal reference line. 

Ø Down row interval (mm): setting the reference distance between row and row below the 
speck of horizontal reference line. 

Ø Down row grads (mm): setting the gradual change value of row distance below the speck of 
horizontal reference line. 

Ø Left column interval (mm): setting the reference distance between column and column of the 
vertical reference line at the left speck. 

Ø Left column grads (mm): setting the gradual change value of speck column distance at the left 
vertical reference line. 

Ø Right column interval (mm): setting the reference distance between column and column of 
the vertical reference line at the right speck. 

Ø Right column grads (mm): setting the gradual change value of speck column distance at the 
right vertical reference line. 

Ø Center offset X/Y (mm): setting the offset of reference line, the center line of light guide 
graphics defaulted as reference line. Setting the offset of X direction to change the position of 
vertical reference line, above zero or not means offset left or right. Setting the offset of Y 
direction to change the position of horizontal reference line, above zero or not means offset 
up or down. 

Ø Row mismatch: tick this item, the speck between row and row array by mismatching. The 
mismatch distance is half of column distance. 

Ø Column mismatch: tick this item, the speck between column and column array by 
mismatching. The mismatch distance is half of column distance. 
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Fig.3-4 Line: lighting from left side and right side 

 

 

Fig.3-5 Line: lighting from right side 
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Fig.3-6 Line: lighting from up and down 

 

Fig.3-7 Line: lighting from down 
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Fig.3-8 Line: unsymmetrical lighting from left and right 

 

Fig.3-9 Line: unsymmetrical lighting from up and down 
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3.1.2 Sweep 

Sweep can set the speck to heavens basing on line. The specks carve by laser head. The 
parameters as follow: 

Ø Direction: setting the direction, allow four directions: X double, X single, Y double, Y single. 
Generally, set X double. 

Ø Scan precision(dpi): setting the carve density of speck sweeping, the unit is column/every 
inch. 

Ø Speck height(mm): setting the referenced height value of speck. 

Ø Height grads(mm): setting the height gradual change value of speck. 

Other parameters are the same as line. 

 

Fig.3-10 Sweep: lighting from up and down 
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Fig.3-11 Sweep: lighting from left and right 

 

Fig.3-12 Sweep: unsymmetrical lighting from up and down 
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Fig.3-13 Sweep: unsymmetrical lighting from left and right 

 

Fig.3-14 Sweep: lighting from down side 
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Fig.3-15 Sweep: lighting from right side1 

 

Fig.3-16 Sweep: lighting from right side2 



SmartCarve43 software manual 

-129- 

 

Fig.3-17 Sweep: lighting from right side3 

 

Fig.3-18 Sweep: lighting from right side4 

 

3.1.3 Grid 

If the grid is drawing line mode, the correlative parameters are invalidation. The correlative 
parameters of gridding line as follow: 
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Ø X direction enable: drawing the beeline of X direction. 

Ø Y direction enable: drawing the beeline of Y direction. 

Enable X direction and Y direction at the same time is gridding line, other parameters setting 
of gridding line is as the same as speck mode, repeat no more. 

 

Fig.3-19 Grid: transverse lighting from up and down 

 

Fig.3-20 Grid: vertical lighting from left and right 
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Fig.3-21 Grid: gridding line lighting from up and down 

 

Fig.3-22 Grid: gridding line lighting from left side 
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Fig.3-23 Grid: gridding line lighting from up side 

 

Fig.3-24 Grid: unsymmetrical lighting from up and down 



SmartCarve43 software manual 

-133- 

 

Fig.3-25 Grid: unsymmetrical lighting from four sides 

 

3.1.4 Drawing Anomalistic Light Guide 

SmartCarve4 create not only the rectangle light guide, but also the anomalistic light guide. 
Example follows: 

1) Polygonal light guide 

 



SmartCarve43 software manual 

-134- 

Fig.3-26  

2) Circular light guide 

 

Fig.3-27  

3) Elliptical light guide  

 

Fig.3-28  

4) Complicated light guide 
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Fig.3-29  

 

3.1.5 Support and Optimize GTools 

Use light guide drawing software “GTools” to create the speck or line figure which more 
specialty and strong function. But the created DXF files larger in widely( over 30M). SmartCarve4 
optimizes the data aim at these figure files. Optimize speed and process path at read, show and 
edit files. 
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Fig.3-30 The speck figure of 600m×600m lighting from three sides( created by GTools, the opened 
time less than 10second) 

 

3.1.6 Carve output 

Presently, light guide figure which draw through SmartCarve 4 can only use No.1.1 controller 
to process. The software has optimized the path of light guide figure, users do not need to optimize 
it in addition. It can use carve output directly or created OUX files, then insert No.1.1 controller to 
process. The default memory space of No.1.1 controller is 32M. Actually, the maximal file transmit 
through U disk or carve output is 16M. Aim at the instance which light guide figure may created the 
biggish file, users can require to make the controller with higher capability ( the most general 
memory is 128M, the most memory of carve output is 32M, transmit by U disk is 96M.) 
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3.2 The Application of Array and Leftover 

To convert the leftover: 

Ø A graphics after convert array as follow: 

 

Fig.3-31  

It can be found that the figures do not fully fill the area, i.e., there is still blank in the left side 
of working area. Now we can add graphics in the blank, as the following picture shows. 

 

Fig.3-32  
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After drawing, select all drafted figures or one by one, and click “Convert Leftover” in the 
right-click menu, as the following picture shows: 

 

Fig.3-33  

After conversion, all the drafted graphics are added to the array, as the following picture 
shows: 

 

Fig.3-34  

Detach Leftover: to detach the leftover in the array. 
Ø Select the arrayed graphics, click “Modify (M)” -> “Dismantle Leftover” or the “Dismantle 

Leftover” item in the right-click menu. 
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Fig.3-35 Before detach 

 
Fig.3-36 After detach 
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3.3 Virtual Print 

3.3.1 Take CorelDrawX3 as an Example 

Now, we will use Windows-XP and CorelDraw X3 to demonstrate. 

1. Start CorelDrawX3, draw a figure or import a figure: 

 

Fig.3-37  

Select “Attribute Manager” from "Edit (E)” in the menu bar and the object attribute page will 
show up: 

 
Fig.3-38  

2. Click “File”->“Print” or press shortcut Ctrl+P, a dialogue box as follows shows up, set “Name 
(N)” as SmartCarve 4 Virtual Printer. 

Set the pen width 
to be fine line in the 
object properties 
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Fig.3-39  

Click “Print” button, switch to SmartCarve4, and the figures drafted in CorelDrawX3 will then 
be imported directly. 

 

Fig.3-40  

 

 
Attention 

In order to make sure the integrality of printing graphics, we suggest to use 
CorelDrawX3 or the above edition. 
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3.3.2 Take AutoCAD2004 as an Example 

System: Window XP 

Software: Auto CAD2004 

A. Start AutoCAD2004, draw a figure or import a figure: 

 
Fig.3-41  

B. Click “File”->“Plot” or press shortcut Ctrl+P, a dialogue box as follows shows up 

 

Fig.3-42  

SmartCarve Virtual Printer 

Plot device 
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Fig.3-43  

Select item “Printing device” and change the “Name (N) in “Printer config” to “SmartCarve 
Virtual Printer”. 

Select item “Printing setup”, set “Scale” as 1:1 and tick off “Center the plot”. For “Graphic 
direction”, user can select “Vertical” or “Horizontal” as required. Here it chooses “Vertical”, and 
click OK to export. 

C. Switch to SmartCarve4, and the figures drafted in AutoCAD2004 will then be imported 
directly. 

 
Fig.3-44  

Warming 

When drawing figures in CorelDraw and importing PLT for printer output, set the pen 
width to fine line. 
In case of printing output in CorelDraw12 or lower version than CorelDRAW9, set in 
“Layout” as 
In CorelDrawX3, it is default as “Page center”. 
In AutoCAD, it is better to print as center at 1:1 scale, which is the actual size. 
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3.4 Translate Tool 

1. Open the LangTool of SmartCarve4: 

Click “tool” →”language”→”translate tool” in the menu of SmartCarve4 or click “Ctrl+T”, as 
follow: 

 

Fig.3-45  

 

Fig.3-46  

2. There are two sides of the translate tool interface. Open the reference language bag at 
the left side. If take English as example, open en_us.xml.  

 

Fig.3-47 Open reference language bag 

Open reference 
language bag 
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Fig.3-48 Open language bag interface (left side) 

3. Click “new” button at the right side of language bag tool, create a new language bag. Or 
click “open” button, open a language bag which need to modify. 

 

Fig.3-49  

4. As above figure, a new language bag be created, the part between the red quotation 
marks are blank, users need to translate by yourselves. Double click the one what you 
want to translate, and then edit it. 

Create a new 
language bag 
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Fig.3-50 Collate and edit language bag 

5. After edit the language bag of right side, click “save” button to save the language. 
Attention: the language must be saved at “language” list of “SmartCarve4”. 

 

Fig.3-51 The saved list of language 

6. A new language bag has finished by the above steps, restart SmartCarve4, we can see 
the language which we created at the language menu, it can be transformed directly. 

7. If users need to pack the language, please set the language bags to our company, we 
will pack them all together. 

Save language bag 

Turkish bag 
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Post 
All final right of interpretation of this manual belongs to our company, we will do our utmost 

efforts to ensure the accuracy of the contents of this manual. We do not assume any responsibility 
caused by misspellings and typing errors. Your comments will be highly appreciated. 

 

 
 
 

 All rights reserved! Reprinting or copy without permission is prohibited. We reserve the right 
of lawing. 

 

 

 

 

 

 

 

 

 


